Screen Data Adjustment Manual

(Upgrading to AGP/AST Series)
Index

Is there any two-point push touch operation? ................................................................. 3
Is any window screen called when a momentary switch is pressed? ............................... 5
Is there a fine-tuning output control by pressing a momentary switch? ......................... 6
Is there any data display with numeric value input? (1)................................................ 8
Is there any data display with numeric value input? (2)................................................ 10
Is there any data display with numeric value input? (3)................................................ 13
Is there any alarm message banner? ............................................................................... 17
Is there any double byte characters displayed? ............................................................. 19
Is there object drawn with Fill? ..................................................................................... 20
Is the careen non-blinking display except lamps and switches? ...................................... 22
Is there any picture loaded from a part? ........................................................................... 24
Is there any 32-bit data display? (1)................................................................................ 28
Is there any 32-bit data display? (2)................................................................................ 30
Is there a CF card used. .................................................................................................... 33
Is there any line graph to show recorded data? ................................................................... 37
Is there a barcode reader connected? ............................................................................... 39
Is there any printer connected to print? .......................................................................... 41
Is there any sound output? .............................................................................................. 47
Are there more than 2 kinds of external devices connected to the touch screen? .......... 49
Is there any internal processing? Is the processing speed the same as before conversion? .................................................................................................................................. 53
**Is there any two-point push touch operation?**

**Description**
The touch panel type of the AGP/AST series differs from that of the previous models. The previous models use the matrix type, on the other hand, the AGP/AST series uses the analog touch panel type, which offers you flexibility of switch positioning because there is no grid.

![Diagram showing switch positioning](image)

**Caution**
The AGP/AST series doesn't support the two-point nor three-point touch, which the previous models support.

![Warning: Two switches cannot be recognized simultaneously](image)
Solution

To replace with the AGP/AST series, change it to the time delay operation of the [Switch/Lamp] part such as ON Delay or OFF Delay feature.

![Diagram showing time delay feature with setting options]

With the time delay feature, turn on the bit for 5 seconds after touching.

If you touch the switch within 5 seconds, the switch performs as same as the two-point touch operation.

Make the settings on one of the switches for the two-point touch operation; the [Switch/Lamp] settings -> [Switch Common] tab -> [Delay Feature].

<table>
<thead>
<tr>
<th>Switch Feature</th>
<th>Switch Common</th>
<th>Lamp Feature</th>
<th>Color</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interlock Feature</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interlock Address</td>
<td>Touch Enable Condition</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enable when Bit is ON</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Delay Feature | | |
|---------------|---------------|
| Delay Action | Delay Time |
| OFF Delay | 5 |
Is any window screen called when a momentary switch is pressed?

**Description**

Between GP-PRO/PBIII and GP-Pro EX, performance when a window is displayed overlapping on a momentary switch differs.

Switch is ON while pressed... OFF when released.

The specified bit will be turned ON as long as you press the Switch. When you take your finger off the Switch, it turns OFF.

**Caution**

The momentary switch’s basic performance is the same; a bit is on while the switch is touched and it is off when untouched.

However, if a window appears on the area of the momentary switch that you are touching, GP-PRO/PBIII keeps the bit on while you are touching. On the other hand, GP-Pro EX turns off the bit in this situation.
**Solution**

The screen data needs to be modified by changing the position or condition of momentary switches if necessary.

Is there a fine-tuning output control by pressing a momentary switch?

**Description**

The previous models allow you to control fine-tuning output by pressing a momentary switch, which is called inching output.

**Direct to DIN unit**

The conveyor moves while the switch is pressed.  
Release, and the conveyor stops.

**Caution**

AGP/ASTseries does not support the inching output.

**Solution**

Please see if the previous model is directly connected to your device’s DIN relay through AUX I/F. If this is the case, there is no alternate method.
However, if your device is not connected directly to the previous model and inching output is simulated by PLC, AGP/AST series can be a replacement.
Is there any data display with numeric value input? (1)

**Description**
In case of that there is a keyboard on the previous model and you use it for entering data, it means that the data display is used as data display with an attribute that allows you to enter numeric values. If you see a keyboard on the screen or keyboard that pops up when you touch, the data display is with the attribute.

![Keyboard Diagram]

**Caution**
The input order that was set up in the previous model may be changed.
Solution

In case that the input order of the data display of the AGP/AST series is different from that of the previous models after conversion, set the [Input Order] feature of the GP-Pro EX data display to input the data in the order as you like.
Is there any data display with numeric value input? (2)

Description

In case of that there is a keyboard on the previous model and you use it for entering data, it means that the data display is used as data display with an attribute that allows you to enter numeric values. If you see a keyboard on the screen or keyboard that pops up when you touch, the data display is with the attribute.

Caution

Within a single Data Display, there is a setting that allows you to indirectly set up for entering numeric values into multiple data registers for both device type and address depending on conditions. If this setting is used in the previous model, you may not be able to write data the same as the previous models.

2 words are used to specify addresses in the previous models, but 4 words are used to specify addresses for AGP/AST Data Display in order to support multi-protocol (device multiple connection).

For example, if you convert a project file which have [Device Type & Address] of [Indirect] settings, located by 2 words between each on, addresses specification will be duplicated.
Solution

To operate them properly, please set the addresses not to duplicate.

Please check [Specify Input Display Range] on in GP-Pro EX. It allows you to set up the necessary settings.

1. Check.
2. Select the address.

3. Set the address.
Is there any data display with numeric value input? (3)

Description

In case of that there is a keyboard on the previous model and you use it for entering data, it means that the data display is used as data display with an attribute that allows you to enter numeric values. If you see a keyboard on the screen or keyboard that pops up when you touch, the data display is with the attribute.

Caution

If there is a base screen called “B0699”, there could be screens that need to be adjusted. This is because there is a part named “n699” in the previous models.
Solution

The part "n699" can be used in lots of screens in the previous models. If it is used in multiple screens, all of the screens need to be modified by following the procedure below.


![Image showing Allow Input option](image)

2. If the key input position and drawing are not aligned, please adjust them on the screen.

![Image showing key input adjustment](image)

3. The unnecessary data display needs to be deleted because the data display and data input
portions are separate functions.

4. If there is a decimal place displayed in data display, a decimal point key needs to be added to the keypad.

5. If there are base screens called B0699 and a keyboard on the screen without any data display, it is possible that the system data area +6 and +7 are used to enter data. In this case, the data display needs to be newly set up and PLC's address needs to be directly specified.

The system data area +6 and +7 are reserved in the AGP/AST series and cannot be used for other purposes.
Is there any alarm message banner?

**Description**

Alarm message banner is a function that an alarm message scrolling from the right to the left when a monitored bit is on.

![Alarm Message Banner Diagram](image)

Scroll the currently triggered Alarms on all screens.

**Caution**

The previous models allow switches, which are placed behind the message banner, to be activated even while an Alarm message is running. However, GP-Pro EX does not.
Solution

To activate switches on the bottom of the screen even while an Alarm message is running, re-edit the screen not to overlap the message banner display area on the switches.

The switch function overlapped by the error display, which is also a system window, is not activated as well.
Is there any double byte characters displayed?

**Description**

Pro-face touch panel screens use the fonts listed below to display text.

<table>
<thead>
<tr>
<th>Font Type</th>
<th>Display Language</th>
<th>Font Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stroke Font</td>
<td></td>
<td>Japanese Stroke Font</td>
</tr>
<tr>
<td></td>
<td>ASCII</td>
<td>Roman Character Stroke Font</td>
</tr>
<tr>
<td></td>
<td>Chinese (Simplified)</td>
<td>Chinese (Simplified) Stroke Font</td>
</tr>
<tr>
<td></td>
<td>Chinese (Traditional)</td>
<td>Chinese (Traditional) Stroke Font</td>
</tr>
<tr>
<td></td>
<td>Korean</td>
<td>Korean Stroke Font</td>
</tr>
<tr>
<td></td>
<td>Cyrillic*1</td>
<td>Cyrillic Stroke Font</td>
</tr>
<tr>
<td></td>
<td>Thai</td>
<td>Thai Stroke Font</td>
</tr>
<tr>
<td>Standard Font</td>
<td></td>
<td>Japanese Standard Font</td>
</tr>
<tr>
<td></td>
<td>ASCII</td>
<td>Standard Font for languages</td>
</tr>
<tr>
<td></td>
<td>Chinese (Simplified)</td>
<td>Chinese (Simplified) Standard Font</td>
</tr>
<tr>
<td></td>
<td>Chinese (Traditional)</td>
<td>Chinese (Traditional) Standard Font</td>
</tr>
<tr>
<td></td>
<td>Korean</td>
<td>Korean Standard Font</td>
</tr>
</tbody>
</table>

*1 Cyrillic letters are mainly used in Russian, Ukrainian, Bulgarian, Byelorussian, Serbian, Macedonian, Kazakh, Kyrgyz, and Mongolian languages.

**Caution**

GP-PRO/PBIII's [Direct Text] is converted to GP-Pro EX's [Direct Text].

Basically, the operation of GP-Pro EX's [Direct Text] is the same as that of GP-PRO/PBIII's [Direct Text]. However, GP-Pro EX does not have selection setup items for GP-PRO/PBIII's [1/2 Kanji Font].

Instead of it, with GP-Pro EX, the Kanji size can be selected in 8 x 8.

In converting data from GP-PRO/PBIII to GP-Pro EX, if the text size of [Direct Text] is set to Half Size, the text size setting after conversion differs in the following conditions.
Solution

Edit the font and its size on the screen if needed.

Is there object drawn with Fill?

Description

Fill is a drawing feature. The pictures below are examples of ones Fill is used to draw.

Caution

GP-PRO/PBIII's [Fill] setting is not supported by GP-Pro EX.

For example, some space may be seen around the border with an arc/pie shapes.

Please note that you cannot edit, or change size, on the [Fill] object.
Solution

Square, rectangle and polygon are converted to a different draw feature after converted to GP-Pro EX. Please edit each object settings.
Is the careen non-blinking display except lamps and switches?

Description
The default setting is Blink in the previous models. However, you can also set non-blinking setting except lamps and switches. With the setting, you can also change the color among 256 colors depending on an address.

Caution
The settings will be changed to [16384 Colors, 3-Speed Blink] after conversion. You will see unexpected blinking after conversion.

Solution
With GP-Pro EX, change the color type to [65535 Colors No Blink].
You can change the setting by following [System Settings Window] -> [Main Unit Settings] -> [Display Settings] -> [Color Settings].

1. Confirm if the [System Settings Window] is displayed. If not, select the [View] menu -> [Work Space] and click [System Settings Window]. The [System Settings Window] will appear in the left of the Editor.
2. Click [Main Unit Settings] in the [System Settings Window].

3. Click ▼ next to [16384 Colors, 3-Speed Blink] of Color Settings in the [Display Settings] area.

4. Select [65535 Colors, 3-Speed No Blink].

The settings are completed.
After transferring the screen data, performance will be the same as before.
<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>With the previous models, you can load the picture of the part even though the part's features cannot be loaded.</td>
</tr>
<tr>
<td>Bit OFF screen</td>
</tr>
<tr>
<td><img src="image" alt="Blank Screen" /></td>
</tr>
<tr>
<td>Bit ONscreen</td>
</tr>
<tr>
<td><img src="image" alt="Part Image" /></td>
</tr>
</tbody>
</table>

**Caution**

With the AGP/AST, it is not possible to load only a picture of parts because it is recognized as a part in GP Pro EX. As the result, you will see unexpected behaviors.
Solution

To display it on GP-Pro EX, replace the Lamp part with a picture.

This section introduces you how to import a bitmap data as a picture of a switch.

1. Open the GP-Pro EX screen on which a part is placed.

2. To make a bitmap file, copy it to any paint application by using the print screen feature of the PC.

3. Cut the “Lamp” part from the image and save it as a bitmap file. (The data types that GP-Pro EX can load are as follows; *.bmp, *.jpeg, *.jpg, *.jpe, *.jfif, *.dpd)

   We recommend you to keep its size to the same as the part.
4. Delete the part on GP-Pro EX and place the image file instead. To place the image data, select the [Draw] menu → [Image Placement]. Select the image data and click the [Open] button to upload the image data.

5. Delete the “Lamp” part placed already on the screen and re-place the uploaded image on the position of the Lamp.
6. It looks the same as before.
Is there any 32-bit data display? (1)

**Description**

In case of that there is a keyboard on the previous model and you use it for entering data, it means that the data display is used as data display with an attribute that allows you to enter numeric values. If you see a keyboard on the screen or keyboard that pops up when you touch, the data display is with the attribute.

You can also handle 32-bit data (over 65536 or negative value) and characters with the display.

<table>
<thead>
<tr>
<th>12345</th>
<th>12345</th>
<th><code>&lt;&gt;</code></th>
<th>CLR</th>
<th>CANCEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>12345</td>
<td>12345</td>
<td>7</td>
<td>8</td>
<td>9</td>
</tr>
<tr>
<td>12345</td>
<td>12345</td>
<td>+</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>12345</td>
<td>12345</td>
<td>4</td>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>12345</td>
<td>12345</td>
<td>BS</td>
<td>PREV</td>
<td></td>
</tr>
<tr>
<td>12345</td>
<td>12345</td>
<td>1</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>12345</td>
<td>12345</td>
<td>DEL</td>
<td>NEXT</td>
<td></td>
</tr>
<tr>
<td>12345</td>
<td>12345</td>
<td>0</td>
<td>.</td>
<td>ENT</td>
</tr>
</tbody>
</table>

**Caution**

Both the previous models and AGP/AST series handle 16 bit as one address, 2 addresses are used for 32-bit data.

However, in case that the minus value or the value that cannot be expressed with 16-bit is written, the result after writing to the device address will be different between the previous model and AGP/AST GP-Pro EX.

e.g.) In case to write "-1"

Software for the previous models

<table>
<thead>
<tr>
<th>K Tag (16 Bit Length)</th>
<th>Device Address (32 Bit Length)</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1</td>
<td>F</td>
</tr>
</tbody>
</table>

GP-Pro EX for AGP/AST
Solution

After conversion, change the data type setting of Data Display to 32 Bit in GP-Pro EX.
**Is there any 32-bit data display? (2)**

**Description**

In case of that there is a keyboard on the previous model and you use it for entering data, it means that the data display is used as data display with an attribute that allows you to enter numeric values. If you see a keyboard on the screen or keyboard that pops up when you touch, the data display is with the attribute.

You can also handle 32-bit data (over 65536 or negative value) and characters with the display.

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>12345</td>
<td>12345</td>
<td>&lt;-</td>
<td>-&gt;</td>
</tr>
<tr>
<td>12345</td>
<td>12345</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12345</td>
<td>12345</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12345</td>
<td>12345</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Caution**

Both the previous models and AGP/AST series handle 16 bit as one address, 2 addresses are used for 32 bit data.

However, the specification of the upper and lower parts of addresses is different when handling 32-bit data. The display behavior will be different between the previous model and AGP/AST GP-Pro EX.

**Solution**

The upper and lower parts of addresses needs to be inverted by using D script.

When writing to the touch screen from the PLC:

1. Write a D-Script program that inverts the upper and lower level of an original address and
(e.g. M+0 and +1) and save it in a different address for internal processing (e.g. LS+1 and +0).

2. Change the original address setting in Data Display to the one created in step 1.

When writing to the PLC from the touch screen:
1. Change the original address setting in Data Display to a different address for internal processing (e.g. LS+1 and +0) from an original address and (e.g. M+0 and +1)
2. Write a D-Script program that inverts the upper and lower level of the address created in step 1 and save it in the original address.

D-Script can be set up in [Parts] -> [D-Script].

LS mentioned above is Internal Address of AGP/AST.
AGP/AST Internal Address range can be used from LS0 to LS9999 in total 10000 Word.
In addition to it, from USR0 to USR29999 in total 30000 Words can be also used.

The following is how to write the D-Script for inverting.

32 bit inverting (READ)
//Inver the upper and lower 16 bit of 32 bit display data of Data Display and store it into LS
if ([b: [PLC1] START_BIT_ADDRESS] == 0)
{
    [w: [#INTERNAL] LS+0 ADDRESS] = [w: [PLC1] DM+1 ADDRESS]
    [w: [#INTERNAL] LS+1 ADDRESS] = [w: [PLC1] DM+0 ADDRESS]
}
endif

Enter the start bit address of the Data Display in “START_BIT_ADDRESS”.
Enter the lower address of the internal processing in “LS+0 ADDRESS”. (e.g. LS2000)
Enter the upper address of the internal processing in “LS+1 ADDRESS”. (e.g. LS2001)
Enter the upper address of the original processing in “DM+1 ADDRESS”. (e.g. DM2001)
Enter the upper address of the original processing in “DM+0 ADDRESS”. (e.g. DM200)
This D-Script is required for each Data Display on the screen.

32 bit inverting (WRITE)
//Write the value of 32 bit Data Display after inverting upper and lower address from LS to DM.
if ([b:[#INTERNAL]LS203201]==0)//When the screen is opened,
{
    [w:[PLC1]DM+0 ADDRESS]=[w:[#INTERNAL]LS+1 ADDRESS]
    [w:[PLC1]DM+1 ADDRESS]=[w:[#INTERNAL]LS+0 ADDRESS]
}
endif

Enter the start bit address of the Data Display in “START_BIT_ADDRESS”.
Enter the upper address of the original processing in “DM+1 ADDRESS”. (e.g. DM2001)
Enter the upper address of the original processing in “DM+0 ADDRESS”. (e.g. DM2000)
Enter the lower address of the internal processing in “LS+0 ADDRESS”. (e.g. LS2000)
Enter the upper address of the internal processing in “LS+1 ADDRESS”. (e.g. LS2001)

This D-Script is required for each Data Display on the screen.
Is there a CF card used.

Description

Various data can be stored in a CF card with both AGP/AST and the previous models that are equipped with a CF card slot.

Caution

Data files in a CF card, which need to be converted, are sound data, image data, and filing data. You can use these data after converting them with the Project Converter and transferring to a CF card again.

<table>
<thead>
<tr>
<th></th>
<th>GP-PRO/PBIII</th>
<th>GP-Pro EX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Screen Data</td>
<td>ZI*****.BIN</td>
<td>I*****.BIN</td>
</tr>
<tr>
<td>Sound Data</td>
<td>ZO*****.BIN</td>
<td>O*****.BIN</td>
</tr>
<tr>
<td>Filing Data</td>
<td>ZF*****.BIN</td>
<td>F*****.BIN</td>
</tr>
</tbody>
</table>

(*****; file number)
Solution

The followings show an example of how to convert a project file with CF card data.

1. Select [Project File (*.prw)] for Data Type.
   
   ![Project Converter Screen](image1)

2. Click [Browse…] in [Convert-From] and specify a GP-PRO/PBIII project file.
   
   ![Open Screen](image2)

3. Click [Browse…] in [Convert-To]. Enter the GP-Pro EX file name after conversion and click [Save].
   
   ![Project Converter Screen](image3)
4. Click [Convert].

5. The confirmation window to ask if you change the data for CF card to that for GP-Pro EX will appear. Click [Yes].
Specify the output destination of the CF card data for GP-Pro EX after conversion. If there is no file available, you can create a new folder by clicking the [Make New Folder] button.

Converting a project file is completed.

If Filing Data function is used in GP-PRO/PB3 and stored filing data in a CF card, please select *.prw as [Convert-From] when converting. If you select CF Card as a file type, the filing data cannot be converted.
Is there any line graph to show recorded data?

Description
The line graph in Pro-face touch screens has a function that shows the past data in the same graph. If there is a line graph in the previous mode’s screen, there could be this usage such as showing a past data on the graph or looking for a trigger of a trend change.

Caution
The switches for [Historical Trend Graph], which are of Special Switch for history display, do not operate on the window.
Solution

Please place the operation keys on the screen directly.
Is there a barcode reader connected?

**Description**

Both the previous models and AGP/AST can be connected to a barcode reader and read values.

```
Touch and...  Read the data.
Beep
```

```
Data is displayed.  Data is stored.
```

**Caution**

The tool port is used for connecting a barcode reader in the previous models while AST/AGP does not support the connection since AGP/AST are not equipped with the port. The barcode reader used with the previous models cannot be used for AP/AST.
Solution

Please have a barcode reader that is supported by AGP/AST and setup it in the GP-Pro EX System Settings.

The settings for barcode reader can be done in [Peripheral Settings] in [System Settings].
**Is there any printer connected to print?**

**Description**

Both the previous models and AGP/AST can be connected to a printer and print out information. The usage could be the following.

1. Screen hardcopy.
2. Alarm history.

![Printer connection diagram]

**Caution**

The AGP/AST's connection method is different from one used in the previous model. It is possible that a printer that supports the same print command as the old printer may not be available in the market.
Solution

To use censorings printer with AGP/AST, USB/PIO conversion is required. Please have USB-PIO converter cable to convert the connector.

There are alternative ways to store screen hard copy or alarm history without having to have a printer. Please refer to the following.

1. Storing screen hard copy images in the CF Card or USB Storage Device

   Setup AGP/AST to capture the screen image that is displayed on the screen.

   1. From the [View (V)] menu, point to [Work Space (W)] and select [System Settings (S)].
2 In the [Display] section, select [Display Unit] to open the [Mode] tab.

3 Select the [Capture Action] check box under [Screen Capture Settings] and select [CF Card] for [Save in].
4 Set D100 in [Control Word Address].

5 A screen capture occurs when the bottom bit in the [Control Word Address] D100 turns ON after storing the file number in the address D102 under [Control Word Address] +2. In the file name [CP*****.jpg], the asterisks represent the file number defined by [Control Word Address]+2.

<table>
<thead>
<tr>
<th>D100 Control</th>
<th>Status</th>
<th>D102 File No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>~</td>
<td>00000</td>
</tr>
</tbody>
</table>

For the screen capture, three consecutive words will be used starting from the specified [Control Word Address].

When the screen capture completes normally, the [Control Word Address] +1’s address "D101" bit 1 turns ON. Confirm this bit ON and then turn OFF "D100" Bit 0.

2. Storing Alarm Messages in the CF Card or USB Storage Device

Saves the alarm history data from the display unit backup SRAM to the CF Card or USB storage. Saved in CSV format, you can edit the alarm data with any spreadsheet application such as Microsoft Excel.
From the [View (V)] menu, point to [Work Space (W)] and select [System Settings (S)].

In the [Display] section, select [Display Unit] to open the [Mode] tab.

Set D100 for example in [Control Word Address].

The Alarm History data stored in the backup SRAM is saved to the CF-card.
4 The settings for writing Alarm History data to the CF Card are now complete.
Is there any sound output?

Description

Both the previous models and AGP/AST can be connected to an external speaker and output sound.

Caution

After converting the sound data via Project Converter, you can use it with the AGP/AST, which you used with the previous models. However, the playback may sound differently from the data of the previous models because the format of the data is different.

For the differences, refer to the following table.

<table>
<thead>
<tr>
<th>Audio Type</th>
<th>GP-PRO/PBIII</th>
<th>GP-Pro EX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sound source</td>
<td>PCM</td>
<td>PCM</td>
</tr>
<tr>
<td>Bit length</td>
<td>16bit</td>
<td>16bit</td>
</tr>
<tr>
<td>Frequency</td>
<td>11kHz</td>
<td>8kHz</td>
</tr>
<tr>
<td>Playback</td>
<td>Monaural</td>
<td>Monaural</td>
</tr>
<tr>
<td>Data type</td>
<td>WAV format</td>
<td>WAV format</td>
</tr>
<tr>
<td>Output destination</td>
<td>\data</td>
<td>\data</td>
</tr>
<tr>
<td>File name</td>
<td>ZO*****.BIN (*****; file number)</td>
<td>O****.BIN (*****; file number)</td>
</tr>
</tbody>
</table>

Solution
Convert the sound data to the GP-Pro EX compatible format by using the Project Converter.
Are there more than 2 kinds of external devices connected to the touch screen?

**Description**

Both the previous models and AGP/AST can be connected to more than 2 kinds of external devices such as PLC and thermo regulator. AGP/AST allows you to select multiple protocols while the previous models allow you only one.

If there are more than 2 kinds of devices connected to the previous model, there can be a program (extended SIO protocol) developed for communication with the external devices.

**Caution**

Extended SIO Script can be converted. However, allocated COM port might be changed or lost after conversion. As the result, there are some cases that the communication could fail.

**Solution**

The solution varies depending on your interface and communication method. Please see the combination of your usage below.

1. After conversion, the PLC type will be assigned to the COM1 port and the assignment of the Extended SIO Script will be canceled.

<table>
<thead>
<tr>
<th>GP-PRO/PBIII</th>
<th>Interface</th>
<th>COM1</th>
<th>COM2</th>
<th>LAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication type</td>
<td>RS-232C</td>
<td>RS-232C</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Usage</td>
<td>PLC protocol</td>
<td>Extended SIO Script</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

After conversion...

(- Unused/Unsupported)

<table>
<thead>
<tr>
<th>GP-Pro EX</th>
<th>Interface</th>
<th>COM1</th>
<th>COM2</th>
<th>LAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication type</td>
<td>RS-232C</td>
<td>RS-422/485</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>
*2: For the same use as before, re-assign the [Extended Script] to COM2 in GP-Pro EX’s [System Settings Window] → [Peripheral Settings] → [Script Settings]. For the RS-232C connection on the COM2 port, however, conversion of RS-232C/422 is required. For more information, contact the nearest Pro-face office.

2. After conversion, the PLC type will be assigned to the COM1 port and the assignment of the Extended SIO Script will be canceled.

<table>
<thead>
<tr>
<th>GP-PRO/PBIII</th>
<th>Interface</th>
<th>COM1</th>
<th>COM2</th>
<th>LAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication type</td>
<td>RS-422</td>
<td>RS-232C</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Usage</td>
<td>PLC protocol</td>
<td>Extended SIO Script</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

After conversion...

(- Unused/Unsupported)

<table>
<thead>
<tr>
<th>GP-Pro EX</th>
<th>Interface</th>
<th>COM1</th>
<th>COM2</th>
<th>LAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication type</td>
<td>RS-232C</td>
<td>RS-422/485</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Usage</td>
<td>PLC protocol</td>
<td>-(*3)</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

*3: For the same use as before, re-assign the [Extended Script] to COM2 in GP-Pro EX’s [System Settings Window] → [Peripheral Settings] → [Script Settings]. For the RS-232C connection on the COM2 port, however, conversion of RS-232C/422 is required. For more information, contact the nearest Pro-face office.

3. After conversion, the PLC type set to COM2 will be assigned to COM1 and the assignment of the Extended SIO Script will be canceled.

<table>
<thead>
<tr>
<th>GP-PRO/PBIII</th>
<th>Interface</th>
<th>COM1</th>
<th>COM2</th>
<th>LAN</th>
</tr>
</thead>
</table>
### GP-Pro EX

<table>
<thead>
<tr>
<th>Communication type</th>
<th>COM1</th>
<th>COM2</th>
<th>LAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-232C</td>
<td></td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Usage</td>
<td>Extended SIO Script</td>
<td>PLC protocol</td>
<td>-</td>
</tr>
</tbody>
</table>

*4: For the same use as before, re-assign the [Extended Script] to COM2 in GP-Pro EX’s [System Settings Window] → [Peripheral Settings] → [Script Settings]. Conversion on the COM2 port of RS-232C422 is required. For more information, contact the nearest Pro-face office.

4. After conversion, the assignment of the [Extended SIO Script] will be cancelled.

### GP-PRO/PBIII

<table>
<thead>
<tr>
<th>Communication type</th>
<th>COM1</th>
<th>COM2</th>
<th>LAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-232C</td>
<td></td>
<td></td>
<td>10BASE-T</td>
</tr>
<tr>
<td>Usage</td>
<td>Extended SIO Script</td>
<td>-</td>
<td>PLC protocol</td>
</tr>
</tbody>
</table>

*5: For the same use as before, re-assign the [Extended Script] to COM2 in GP-Pro EX’s [System Settings Window] → [Peripheral Settings] → [Script Settings]. Rewiring is also required.
because the pinout of the COM1 is different. For more information, contact the nearest Pro-face office.

5. After conversion, the [Extended SIO Script] set in COM2 will be assigned to COM2. Any change of settings is unnecessary.

<table>
<thead>
<tr>
<th>GP-PRO/PBIII</th>
<th>COM1</th>
<th>COM2</th>
<th>LAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication type</td>
<td>-</td>
<td>RS-232C</td>
<td>10BASE-T</td>
</tr>
<tr>
<td>Usage</td>
<td>-</td>
<td>Extended SIO Script</td>
<td>PLC protocol</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>GP-Pro EX</th>
<th>COM1</th>
<th>COM2</th>
<th>LAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication type</td>
<td>RS-232C</td>
<td>-</td>
<td>10BASE-T</td>
</tr>
<tr>
<td>Usage</td>
<td>Extended SIO Script</td>
<td>-</td>
<td>PLC protocol</td>
</tr>
</tbody>
</table>
### Description

With the previous models, there can be D-script that operates arranging the fine timing by using Scan Time or Scan Counter.

### Caution

Between the AGP/AST series and the previous models, screen-processing speed differs depending on the performance of the hardware. After the project file conversion, it may not operate at the same timing with the AGP/AST series.

### Solution

It is not possible to determine the settings on the PC. Please carry an operation tuning after downloading screen data to AGP/AST.